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JOOMLA 1.5.14 
CÀI ĐẶT 
TRÊN HOST FREE : 
WWW.BYETHOST.COM 
 
 

 
 
 

 

BÀI 3 NGÀY 26.8.2009 UTBINH SOẠN  
 
UTBINH ĐÃ HƢỚNG DẪN CHO CÁC BẠN CÀI ĐẶT PHẦN MỀM JOOMLA 1.5.14 TRÊN 

HOST MUA VÀ LOCALHOST . TRONG LÚC TỰ TÌM HIỂU VÀ HỌC HỎI NƠI BẠN BÈ , TRÊN 
MẠNG , TRÊN FORUMS UTBINH CỐ GẮNG VIẾT TỪNG BÀI HƢỚNG DẪN TRÌNH BÀY 

SAO CHO THẬT NHIỀU CHI TIẾT – NHIỀU HÌNH MINH HỌA ( SAU NÀY SẼ CUNG CẤP 
THÊM CÁC FILES VIDEO TUTORIALS NỬA ) ĐỂ GIÚP CÁC BẠN NHANH CHÓNG LÃNH 
HỘI HẾT CÁC THÀNH PHẦN CẦN THIẾT HẦU ĐẠT KẾT QUẢ CUỐI CÙNG LÀ THỰC TẬP 

CÀI ĐẶT ĐƢỢC JOOMLA TRÊN HOST SERVER . MÌNH VIẾT MÀ KHÔNG AI HIỂU ĐƢỢC 
THÌ CHỈ UỔNG CÔNG BỎ RA THÔI , PHẢI KHÔNG CÁC BẠN . UTBINH RẤT MONG ĐÓN 

NHẬN ĐƢỢC LỜI CHỈ GIÁO BỔ SUNG CỦA CÁC PRO GIÚP UTBINH HỌC NHANH HẦU 
GIÚP CHO CÁC BẠN DỞ HƠN UTBINH CÓ CƠ HỘI TIẾP XÚC VỚI JOOMLA ĐÊ THIẾT KẾ 

ĐƢỢC 1 TRANG WEB HOÀNH TRÁNG , THỜI THƢỢNG . 
UTBINH BẢO ĐẢM VỚI CÁC BẠN LÀ NHỮNG BÀI VIẾT NÀY KHÔNG ĐỤNG HÀNG , CÓ 
NGHĨA LÀ RẤT TỈ MĨ VÀ CHI TIẾT ĐÔI KHI DÀI DÕNG NHƢNG XÉT THẤY RẤT HỮU ÍCH 

CHO NEW BIE VÀ CŨNG LÀ BẢN TÁNH MANG TÍNH CHẤT RIÊNG STYLE CỐ HỮU CỦA 
UTBINH . 

TẠI SAO CŨNG CHỈ LÀ 1 PHẦN MỀM LÀM SẴN ĐỂ THIẾT KẾ WEB LÀ JOOMLA MÀ 
UTBINH LẠI VIẾT ĐẾN 3 BÀI ? RẤT DỄ HIỂU LÀ TRƢỚC KHI THÀNH THẠO TẠO 
WEBSITE BẰNG JOOMLA NÀY ( LÀ 1 PHẦN MỀM KHÓ NUỐT KHI CÀI ĐẶT LÊN HOST 

SERVER ) BẠN PHẢI THỰC TẬP NHUẦN NHUYỂN TRÊN 1 SERVER ẢO , ĐÓ LÀ 
LOCALHOST ĐƢỢC CÀI ĐẶT TRONG Ổ CỨNG CỦA BẠN CHỚ KHÔNG CÓ UPLOAD ĐI 

ĐÂU XA CẢ . SAU KHI KIỂM TRA TRANG WEB VỪA THIẾT KẾ XONG BẠN MỚI BẮT ĐẦU 
ĐỘNG TÁC  UPLOAD LÊN HOST SERVER . VÌ LÀ TÌM HIỂU VÀ THỰC TẬP THIẾT KẾ WEB 

DO ĐÓ BẠN CẦN PHẢI CÓ 1 HOST SERVER ĐỂ UPLOAD FOLDER WEBSITE LÊN MÁY 
CHỦ WEB . BẠN MỚI HỌC THIẾT KẾ WEB VẢ LẠI KHÔNG PHẢI LÀ CHUYÊN VIÊN THIẾT 
KẾ WEB GIA CÔNG ĂN TIỀN , BẠN KHÔNG CẦN PHẢI MUA HOST , HOST FREE CÓ RẤT 

NHIỀU TRÊN MẠNG GIÚP BẠN TẠO 1 ACCOUNT RỒI TẢI WEBSITE CỦA BẠN LÊN . 
TRONG RỪNG HOA HOST FREE ĐÓ , UTBINH GIỚI THIỆU 1 HOST NUMBER ONE ĐÃ 

ĐƢỢC UBTINH CHỌN MẶT GỞI VÀNG , ĐÓ LÀ : WWW.BYETHOST.COM . SAU NÀY KHI 
DƢ DẢ TIỀN BẠC , MUỐN CÓ ĐẤT RIÊNG DỤNG VÕ , BẠN TẬU 1 HOST ĐỂ GỞI GẤM CÁC 

TRANG WEB ĐIÊU LUYỆN CỦA BẠN GIỚI THIỆU NGƢỜI XEM BẰNG NHỮNG LINKS URL 
HOẶC BẮT ĐẦU ĐI LÃNH THIẾT KẾ THUÊ , QUẢN LÝ WEBSITE ĐÓ BẰNG PHẦN MỀM 
JOOMLA HAY THIẾT KẾ BẰNG CHƢƠNG TRÌNH DREAMWEAVER – FRONTPAGE . 

http://www.byethost.com/
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Tâm sự : Utbinh rất lấy làm khoan khoái vì viết xong 3 bài này . Với chủ đề khó nuốt , 
lúc bắt đầu viết Utbinh lo sợ sẽ không thành công vì có nhiều giai đoạn phải hoàn tất 

từng bƣớc một rồi mới qua phần kế tiếp . Nếu không đúng bài bản thì sẽ không hiện ra 
bƣớc kế tiếp cho bạn cài đặt nửa và thế thì bạn phải dừng lại không viết tiếp đƣợc nửa 

Mỗi bài có cái khó riêng của nó do đặc điểm của từng loại . Utbinh cố gắng đọc nhiều 
lần , nhiều bài hƣớng dẫn trên Forums và trên các bài của Pro nhƣng tựu trung thì 

những bài này viết rất ngắn gọn , đòi hỏi bạn phải có 1 trình độ nhất định để suy diễn 
mới lãnh hội đƣợc . Utbinh tâm niệm mình cố gắng tự tìm hiểu từng bƣớc và viết lại 1 
cách “ rất chi tiết “ - rất giản dị - cố gắng chụp Hình Minh Họa nhiều để hổ trợ cho nội 

dung văn bản vốn khó hiểu , khô khan  -  khó diễn đạt và cuối củng Utbinh đã thành 
công . Utbinh bảo đảm bạn đọc qua sẽ hiểu hết và sẽ thực hành đạt kết quả nhƣ mong 

muốn . Đó là sự thành công mà Utbinh muốn chia sẻ đến các bạn mới tập tểnh bƣớc 
vào Môn Thiết Kế Web nhất là Web JOOMLA . Và một điều tự hào là 3 bài viết dài – chi 
tiết , chất lƣợng này bảo đảm chƣa có Forums nào có . Utbinh có tâm niệm : Khi đã làm 

1 việc gì hữu ích cho con em của chúng mình thì phải dọn những món ăn ngon – bổ  - 
miễn phí để các em lãnh hội đƣợc trọn vẹn – dễ dàng thực tập và đạt kết  tốt . Đó là 

monh ƣớc nhỏ nhoi của Utbinh khi có dịp cống hiến cho giới trẻ Việt Nam  hiếu học và 
đam mê tin học nhƣ Utbinh vậy . Nếu có gì không hiểu xin thƣ cho Utbinh : 

utbinhdesign@gmail.com hay điện thoại số 08.3890.2100 . Utbinh sẽ sẵn sàng giải đáp 
mọi thắc mắc cho bạn . 

 

I.TỔNG QUÁT 
 

1.GIÁO TRÌNH UTBINH ĐÃ SOẠN : 

 
42 BÀI FRONTPAGE 2003 UTBINH SOẠN ĐỢT 3 : FRONTPAGE_2003_42LESSONS.rar 

(58.34 MB) : http://tinyurl.com/utbinh008  
hoặc : http://www.mediafire.com/download.php?4qw252xmktn 

45 BÀI FRONTPAGE 2003 UTBINH SOẠN ĐỢT 1 VÀ 2 (35.91MB): 
http://tinyurl.com/utbinh009 

34 BÀI DREAMWEAVER 8 UTBINH SOẠN (21.17MB): http://tinyurl.com/utbinh142 
52 Bài Thiết Kế Web HTML utbinh soạn (46.07MB)  : http://tinyurl.com/utbinh0010 
15 Bài Expressions Web  utbinh soạn (36.92MB) : http://tinyurl.com/utbinh0012 

39 Bài Power Point utbinh soạn ( 47.50 MB ) : http://tinyurl.com/43ogba 
26 Bài Flash 8 utbinh soạn (22.99MB) : http://tinyurl.com/utbinh0014 

DREAMWEAVER CS3 6 Bài viết của utbinh đến ngày 12.8.2009 : 
http://tinyurl.com/utbinh0015 . Đây là Shared Links Mediafire trong đó có Soft của 

chƣơng  trinh và Link này DREAWEAVERCS3_6BAI.rar (7.65MB) . 
8 Lessons Dreamweaver CS3 CHM do utbinh biên soạn  ( 3.48MB ) : 
http://tinyurl.com/utbinh0017 

Bạn tham khảo 11 Bài viết Hƣớng dẫn tạo Video Clips bằng cách Download File nén và 
giải nén chúng tại : http://tonyurl.com/utbinh0018 

Bạn cũng có thể Upload từng Video Clips này lên YOU TUBE để giới thiệu bạn hữu xem 
, mở trang này để tìm hiểu cách Upload Video Clips lên You Tube và tạo Channel trong 
này : http://utbinh.com/A2/170209/FLV.doc  

http://utbinh.com/A3/180309B/OrbitDownloader.doc 
Bạn cũng có thể xem các Video Hƣớng dẫn do utbinh soạn thảo tại : 

http://tinyurl.com/utbinh0019 

 

mailto:utbinhdesign@gmail.com
http://tinyurl.com/utbinh008
http://www.mediafire.com/download.php?4qw252xmktn
http://tinyurl.com/utbinh009
http://tinyurl.com/utbinh142
http://tinyurl.com/utbinh0010
http://tinyurl.com/utbinh0012
http://tinyurl.com/43ogba
http://tinyurl.com/utbinh0014
http://tinyurl.com/utbinh0015
http://www.mediafire.com/download.php?z1emdeiyd5n
http://tinyurl.com/utbinh0017
http://tonyurl.com/utbinh0018
http://utbinh.com/A2/170209/FLV.doc
http://utbinh.com/A3/180309B/OrbitDownloader.doc
http://tinyurl.com/utbinh0019
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2.MỜI CÁC BẠN ÔN TẬP LẠI 2 BÀI TRƢỚC : 
 

1. Cài đặt Joomla trên Host Mua : 
http://utbinh.com/A8/230809/CAIDAT_JOOMLA.doc 
http://utbinh.com/A8/230809/CAIDAT_JOOMLA.pdf 

2. Cài đặt Joomla trên LocalHost : 
http://utbinh.com/A8/230809/localhost.doc 
http://utbinh.com/A8/230809/localhost.pdf 
 

 

3. CÁC GIAI ĐOẠN TIẾN HÀNH : 
 

1. Tạo Account tại Host Server Free : www.byethost.com . 
2. Dowload Software : Joomla 1. 5. 14 . 
3. Download,Cài đặt ChƣơngTrình Upload FTP: CuteFTP 8.3 Pro  
4. Upload Software Joomla lên Host Server Free . 
5. Tạo Database  trong Host Free : www.byethost.com . 
6. Cài đặt Software Joomla 1.5.14 . 

 

 
I.TẠO ACCOUNT TẠI HOST FREE : WWW.BYETHOST.COM 
  

SAU KHI BẠN THIẾT KẾ HOÀN TẤT 1 WEBSITE ,TẤT CẢ CÁC FILES VÀ FOLDERS NỘI 

DUNG CỦA NÓ ĐƢỢC CHỨA TRONG 1 FOLDER TÊN FOLDER WEBSITE (SITE010709) 
CẦN PHẢI ĐƢỢC UPLOAD LÊN HOST SERVER ĐỂ LẤY LINK URL GIỚI THIỆU CHO 

NGƢỜI XEM (USERS) . HOST SERVER CÓ THỂ LÀ 1 HOST MUA HAY FREE . HIỆN NAY 
CÁC BẠN KHÔNG ĐỦ KHẢ NĂNG MUA HOST HOẶC PHƢƠNG THỨC THANH TOÁN KHI 

MUA HOST PHỨC TẠP – KHÓ KHĂN TẠI VIỆT NAM , VẬY BẠN CẦN PHẢI TÌM VÀI HOST 
FREE ĐỂ UPLOAD FOLDER WEBSITE CỦA BẠN . VẢ LẠI TRONG LÚC HỌC VÀ TẬP THIẾT 
KẾ WEB BẠN CẦN PHẢI THỰC TẬP TẠO VÀI TRANG WEB LÖC BAN ĐẦU CÓ NHIỀU SƠ 

SÓT CẦN HOÀN CHỈNH RÚT KINH NGHIỆM CHO BẠN . VẬY TÌM HOST FREE TRONG 
GIAI ĐOẠN NÀY LÀ THÍCH HỢP NHẤT . VỚI CẢ RỪNG HOST FREE THÌ LÀM SAO BIẾT 

ĐƢỢC CÁI NÀO HAY – CÁI NÀO UPLOAD NHANH – DOWNLOAD CŨNG NHANH VÀ 
BĂNG THÔNG NHIỀU – SỐNG LÂU ? RẤT DỄ TÌM , BẠN VÀO WWW.GOOGLE.COM.VN 
NHẬP : HOST FREE TỐT NHẤT > ENTER LÀ XONG HOẶC ĐỌC TRONG CÁC FORUMS CÁC 

MỤC GIỚI THIỆU HOST FREE . UTBINH ĐÃ TỪNG GIỚI THIỆU CÁC HOST FREE CHO 
CÁC BẠN TRONG LÖC HƢỚNG DẪN TIẾT KẾ WEB . TUY NHIÊN QUÁ TRÌNH SỬ DỤNG 

THÌ UTBINH NHẬN XÉT HOST FREE : BYETHOST LÀ TỐT NHẤT VÌ VẬY HÔM NAY 
UTBINH VIẾT CHUYÊN ĐỀ VỀ HOST FREE NÀY  LẦN THỨ 2 MONG CÁC BẠN QUAN TÂM 

SỬ DỤNG NÓ KHI THIẾT KẾ WEB . NGOÀI BÀI HƢỚNG DẪN BẰNG TEXT CÒN CÓ CÁC 
FILES VIDEO TUTORIAL SẼ GIÚP BẠN LÃNH HỘI TRỌN VẸN ĐỂ ĐẠT KẾT QUẢ SỬ DỤNG  

 
DOWNLOAD FILES VIDEO TUTORIALS : 
 
Video Định dạng AVI cực rõ tạo bằng Chƣơng Trình Camtasia Studio 6.0.1 
(http://tinyurl.com/utbinh174 )  

http://utbinh.com/A8/230809/CAIDAT_JOOMLA.doc
http://utbinh.com/A8/230809/CAIDAT_JOOMLA.pdf
http://utbinh.com/A8/230809/localhost.doc
http://utbinh.com/A8/230809/localhost.pdf
http://www.byethost.com/
ftp://ftp 8.3/
http://www.byethost.com/
http://www.byethost.com/
http://www.google.com.vn/
http://tinyurl.com/utbinh174
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Hƣớng dẫn tạo ACCOUNT và sử dụng Host Free BYETHOST : 
http://tinyurl.com/utbinh189 

HOST FREE BYETHOST ngày 5 7 2009 Tập 1  
http://www.youtube.com/watch?v=xY8JC_sDyZo 

HOST FREE BYETHOST ngày 5 7 2009 Tập 2 HẾT  
http://www.youtube.com/watch?v=r-zVgeAeR6I 

 

ĐỌC THÊM TÀI LIỆU HƢỚNG DẪN SỬ DỤNG BYETHOST : 
 
Hƣớng Dẫn Cài Đặt WordPress Với ByetHost Cho Newbies (Updated) : 
http://blogviet.info/2009/02/huong-dan-cai-dat-wordpress-voi-byethost-cho-

newbies/ 
Cách tạo website và forum tại www.byethost.com bằng joomla và vBulletin : 

http://forum.gamevn.com/showthread.php?t=319040 
Tìm Hiều Host Free : BYETHOST trong Shared Mediafire : 
http://tinyurl.com/utbinh188 

 

I.ĐĂNG KÝ TẠO ACCOUNT  
  

1. Vô : http://byethost.com/ > Nhấp Free Hosting > Nhấp  : Click here to sign up 

for free hosting  
2. Ra Trang Sign Up for Free Hosting , Bạn nhập các Thông Tin vào Ô trống theo 

Hình Minh Họa dƣới đây : 

 
 

 
 

 
 
 

 
 

 
 

 
 
 

 
 

 
 

 
 
 

 
 

 
 
 

3. Ra Trang kế tiếp , nhấp Click Me To Continue . 

http://tinyurl.com/utbinh189
http://www.youtube.com/watch?v=xY8JC_sDyZo
http://www.youtube.com/watch?v=r-zVgeAeR6I
http://blogviet.info/2009/02/huong-dan-cai-dat-wordpress-voi-byethost-cho-newbies/
http://blogviet.info/2009/02/huong-dan-cai-dat-wordpress-voi-byethost-cho-newbies/
http://forum.gamevn.com/showthread.php?t=319040
http://tinyurl.com/utbinh188
http://byethost.com/
http://byethost.com/free-hosting/news
http://byethost.com/free-hosting/news
http://byethost.com/free-hosting/news
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4. Ra Trang Image Verification , bạn nhập từ ở trên vào Ô trống và nhấp Register  

 

 
  

 
 

 
 
 

 
 

 
 

 
 
 

 
 

5. Ra Trang kế tiếp với thông báo yêu cầu bạn mở Hộp Thƣ đăng ký để nhấp kích 
hoạt Tài Khoản  
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6. Mở Hộp Thƣ đã dăng ký để nhận E-mail > Nhấp lên Link để kích hoạt Tài Khoản 
Bạn chú ý  cùng 1 Hộp Thƣ nhƣng bạn vẫn đƣợc phép đăng ký tạo nhiều Account  

 

7. Ra Trang Image Verification , bạn nhập 2 từ trên vào Ô trống > Nhấp Register  
 

 
 
 

 
 

 
 
 

 
 

 
 

 
 
 

 
 

 
 

 
8. Ra Trang Byethost15.com signup thông báo các chi tiết về Files and FTP Settings 

( Tên URL – Username – Password ) để bạn tạo Site Manager  trong Chƣơng 

Trình Upload bằng giao thức FTP . Riêng về sử dụng Control Panel – MySQL 
Settings – Domain Name bạn tham khảo trong : http://tinyurl.com/utbinh188 > 

Nhấp lên chữ Save màu xanh đáy Trang để Download File PDF Thông Báo nội 
dung Tài Khoản của bạn đã Dăng Ký trong Byethost . Bạn cần save File này để sử 
dụng Khi tạo Site manager . 

 

http://tinyurl.com/utbinh188
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9. Ngoài ra bạn cần phải mở Hộp thƣ để nhận thông báo chánh thức của Host nội 

dung sau :  
 

Kính thƣa quý khách hàng có giá trị,  
Cám ơn bạn đã đăng ký tại byethost15.com. Chúng tôi đang delighted để thông 
báo cho bạn rằng đơn của bạn b15_3722400 đã đƣợc thành công!  

Tài khoản của bạn đã đƣợc kích hoạt, và bạn sẽ có thể đăng nhập vào cPanel 
ngay bây giờ. Hãy cẩn thận lƣu ý về đăng nhập của bạn thông tin chi tiết dƣới 

đây và xem xét việc in ấn chúng cho hồ sơ của riêng bạn.  
Nếu bạn muốn dịch vụ lƣu trữ miễn phí của chúng tôi, xin vui lòng xem xét việc 

nâng cấp tài khoản của bạn để một trong những Premium Hosting Gói cƣớc của 
chúng tôi và nhận đƣợc miễn phí. COM, NET hay Thông tin tên miền:  
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Tiền đóng bảo hiểm đƣợc thanh toán của chúng tôi đã có dịch vụ lƣu trữ rất lớn 
lƣu trữ các kế hoạch sử dụng các ngành công nghiệp hàng đầu cPanel X bảng 

điều khiển, mà không có bất kỳ giới hạn hoặc hạn chế đƣợc đặt trên các tài 
khoản miễn phí lƣu trữ chẳng hạn nhƣ PHP sockets, CPU hạn ngạch, SMTP & 

POP tài khoản email, không có kích thƣớc tập tin các giới hạn và nhiều hơn nữa, 
tất cả đều đƣợc lƣu trữ trên cực kỳ nhanh chóng quad CPU máy chủ.  

Để biết thêm thông tin xin vui lòng ghé thăm: https: / / securesignup.net / cổng 
  
ĐÂY LÀ CÁC THÔNG SỐ KỸ THUẬT DO HOST FREE CUNG CẤP CHO CÁC BẠN 

TRONG VÍ DỤ ĐÃ ĐĂNG KÝ TẠO ACCOUNT TRÊN . CÁC BẠN CÓ THỂ LẤY NÓ ĐỂ 
DÙNG CHO GIAI ĐOẠN UPLOAD SOFTWARE JOOMLA 1.5.14  

 
                CPanel Tên: b15_3722400  
                CPanel Mật khẩu: 05072009  

                URL của bạn: http://thunam.byethost15.com hoặc 
                http://www.thunam.byethost15.com  

                FTP Server: ftp.byethost15.com  
                FTP Đăng nhập: b15_3722400  

                Mật khẩu FTP: 05072009  
                Tên cơ sở dữ liệu MySQL: PHẢI TẠO TẠI cPanel  
                Tên ngƣời dùng MySQL: b15_3722400  

                Mật khẩu MySQL: 05072009  
                MySQL Server: SEE THE cPanel  

                CPanel URL: http://cpanel.byethost15.com  
                

Một khi bạn đã đăng nhập vào VistaPanel của bạn, bạn có thể thay đổi mật khẩu 
của bạn nếu cần.  
Xin vui lòng đăng ký tại diễn đàn của chúng tôi http://byet.net, nơi bạn có thể 

nói chuyện và trao đổi ý kiến với các webmaster.  
Để hỗ trợ các chi phí cao, chất lƣợng cung cấp cho máy chủ web, xin vui lòng 

bạn có thể thêm những Advert vào trang web của bạn:  
<iframe src="http://byet.org/468x60.php" width="469" height="61" 

scrolling="no" frameborder="0" name="content"> </ khung nội tuyến>  
hoặc <iframe src="http://byet.org/728x90.php" width="729" height="91" 
scrolling="no" frameborder="0" name="content"> </ khung nội tuyến>  

Để có quyền truy cập vào của chúng tôi knowledgebase / Troubleshooters xin 
vui lòng Goto http://tutorials.securesignup.net/ Để tham gia sự thân thiện mới 

để thay thế cho myspace và facebook, xin vui lòng truy cập 
http://mybookface.net Để hỗ trợ kỹ thuật, xin vui lòng sử dụng các hệ thống hỗ 
trợ nằm trong cPanel của bạn. Cảm ơn bạn đã lựa chọn byethost15.com và 

thƣởng thức các tài khoản lƣu trữ miễn phí của bạn! byethost15.com Hosting. 
 

10. ĐÂY LÀ CÁC THÔNG SỐ KỸ THUẬT ÁP DỤNG CHO BÀI VIẾT NÀY  DO HOST FREE 
CUNG CẤP CHO KHI  ĐĂNG KÝ TẠO ACCOUNT . CÁC BẠN CÓ THỂ LẤY NÓ ĐỂ 

DÙNG CHO GIAI ĐOẠN UPLOAD SOFTWARE JOOMLA 1.5.14  . 
 

Welcome to byethost33.com your account details are: 

 
Cpanel URL : http://panel.byethost.com 

Cpanel Username (FTP/SQL): b33_3721618 
Cpanel Password (FTP/SQL): 05072009 

MySQL Hostname: sql306.byethost33.com 

http://www.thunam.byethost15.com/
http://cpanel.byethost15.com/
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MySQL Username (FTP/SQL): b33_3721618 
MySQL Password (FTP/SQL): 05072009 

FTP Server: ftp.byethost33.com 
FTP Username (FTP/SQL): ftp.byethost33.com 

FTP Password (FTP/SQL): 05072009 
Website URL: http://chunhat.byethost33.com 

 
 Hƣớng dẫn cách dùng các thông số này : 
 

¶ Cpanel URL : http://panel.byethost.com 

Bạn cần vào Control Panel để tạo Database , bạn nhập Link : 
http://panel.byethost.com > Nhập UserName : b33_3721618 và Password 
: 05072009 

¶ Cpanel Username (FTP/SQL): b33_3721618 
¶ Cpanel Password (FTP/SQL): 05072009 

Vào Control Panel bằng cáh nhập : Username và Password này dùng chung 

cho FTP và SQL  
¶ Khi trong MySQL  đòi hỏi Host Name – User name – Password thì bạn nhập  

MySQL Hostname : sql306.byethost33.com 
MySQL Username (FTP/SQL) : b33_3721618 

MySQL Password (FTP/SQL) : 05072009 
¶ Website URL: http://chunhat.byethost33.com . Nhập Link URL này /Tên 

Folder Website / index.html . Đó là Link URL của Trang Web của bạn . 
Trong phần hƣớng dẫn tiếp theo các bạn sẽ hiểu rõ thêm cách dùng này . 

 
 

II.DOWNLOAD SOFTWARE JOOMLA 1.5.14 
 

1. Vô : http://joomlaviet.org/ > Nhấp Download . (H1) . 
 
 

 
 

 
 

 
 
 

 
 

 
 
 

 
 

 
 

 
2. Ra Trang Joomla , nhấp lên Joomla_1.5.12_to_1.5.14-Stable-Patch_Package.zip 

(3.93MB) . (H2) . 

ftp://ftp.byethost33.com/
ftp://ftp.byethost33.com/
http://chunhat.byethost33.com/
http://panel.byethost.com/
http://chunhat.byethost33.com/
http://joomlaviet.org/
http://joomlacode.org/gf/download/frsrelease/10786/42667/Joomla_1.5.12_to_1.5.14-Stable-Patch_Package.zip
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3. Ra Bảng Download File Info , nhấp Nút Browse ( Ô vuông 3 chấm ) > Chọn nơi 
lƣu là Desktop > Nhấp Nút Start Download , dung lƣợng 3.92 MB . ( Với điều 
kiện trƣớc đó bạn đã cài IDM ) . (H3) . 

 
 

 
 

 
 
 

 
 

 
 

 
4. Sau khi Download hoàn tất , bạn ra Desktop đã thấy File nén > Tạo  Folder tên : 

byethost đặt tại Desktop > Rê File nén vào đây > Giải nén và Delete File nén . 

 

III.DOWNLOAD – CÀI ĐẶT CUTE FTP 8.3 PRO 
 

Chƣơng trình CuteFTP là một công cụ FTP dựa trên hệ điều hành 
Windows. Nó cho phép bạn khai thác tối đa các khả năng của FTP mà 
chẳng cần phải biết chi tiết về bản thân giao thức này. Chỉ cần làm quen 

với CuteFTP là đủ rồi. Khi bạn có đƣợc một địa chỉ FTP server, CuteFTP có 
thể đƣa bạn vào sục sạo kho tƣ liệu công cộng (pub) của Server đó. Và khi 
chọn đƣợc file cần đến, bạn có thể ra lệnh cho CuteFTP load về máy bạn. 
CuteFTP giờ đây có thêm nhiều chức năng tuyệt vời hơn. Bạn có thể copy 
và paste các địa chỉ URL vào CuteFTP hoặc cho CuteFTP kết hợp với trình 
duyệt Web (browser) của bạn. Khi bạn tìm thấy 1 link FTP, hãy copy URL 

đó vào clipboard và CuteFTP sẽ tự động download file đó về cho bạn. Một 
tính năng độc đáo nữa của CutrFTP là resume (download trở lại). Nếu nhƣ 

ftp://ftp 8.3/
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server có hỗ trợ chức năng resume, bạn có thể tạm dừng (pause) công 
việc download nửa chừng để rồi sau này khi rảnh có thề dùng CuteFTP 
tiếp tục down load phần còn lại của file đó về. Ðặc biệt đây là một trong 
những phần mềm phân biệt rất rõ và chính xác các chữ viết thƣờng và IN 
HOA, thích hợp với các server dùng UNIX .Các ƣu điểm khi dùng công cụ 
FTP Connect : Đối với phần mềm Total Commader có một điều thú vị là khi 

cài đặt lần đầu tiên thì chƣơng trình sẽ copy toàn bộ dữ liệu vào trong 
phân vùng ổ cứng. Khi bạn muốn sử dụng ở máy tính khác thì bạn chỉ việc 
chép thƣ mục cài đặt của chƣơng trình vào và chạy file TOTALCMD.exe để 
chƣơng trình hoạt động mà không phải cài đặt lại. Nếu bạn đã từng sử 
dụng một chƣơng trình chuyên dùng upload dữ liệu nhƣ: FTP Voyager, 
Cute FTP,... thì có lẽ bạn hay gặp phải tình trạng “giữa đƣờng đứt gánh” 

nhƣng lại không thông báo cho bạn biết vì thế xảy ra tình trạng file 
download về không sử dụng đƣợc. Với Total Commander sẽ cho phép so 
sánh ngay tức thì dung lƣợng thực sự giữa file nguồn và file upload chính 
xác đến từ byte. Vì thế tránh đƣợc tình trạng Corrupt File thƣờng gặp. Tốc 
độ thực hiện công việc chuyển tải thông suốt và nhanh hơn rất nhiều các 
chƣơng trình khác. Bạn có thể upload các file dung lƣợng lớn từ vài chục 

cho đến vài trăm MB rất dễ dàng. Thao tác cʠu hình và sλ dγng rʠt Ľʅn giʞn: 
CuteFTP Professional là một phần mềm để chuyển files qua nhiều giao 
thức internet giữa máy tính của bạn tới các máy tính bất kỳ nơi nào trên 
internet một cách an toàn và hiệu quả. Chức năng Connection Wizard tích 
hợp trong phần mềm sẽ hƣớng dẫn bạn kết nối tới một site fxp trong vài 
giây và giao diện thân thiện của phần mềm sẽ giúp bạn chuyển file dễ 

dàng ngay khi bạn là ngƣời mới sử dụng. Kể cả việc xuất một trang web, 
download những hình ảnh kỹ thuật số, phần mềm, file nhạc mới nhất hoặc 
chuyển file có dung lƣợng lớn giữa các văn phòng chi nhánh.CuteFTP 
Professional cung cấp các công cụ đơn giản mà mạnh mẽ để giải quyết 
những thách thức phức tạp trong quản lý dữ liệu và giúp hoàn tất các yêu 
cầu về HIPAA, GLBA về Sarbanes-Oxley. CuteFTP Professional đƣợc giới 

chuyên môn đánh giá cao nhất về độ an toàn và tiện ích nó mang lại khi 
vận chuyên files.  
 
 
I.CÁCH TÌM SOFWARE NẦY : 
(Đọc bài Số 3.FRONTPAGE 2003 : http://utbinh.com/ANOV08/131108/9down.doc) 

 
1. Vô : http://www.9down.com > Rê Thanh Trƣợt , tìm trong Cột Phải > Đến Mục 

NetWork Tools , nhấp lên : CuteFTP Pro > Hiện ra : cuteFTPpro v8.3.2.Buils 
09.02.2008.1 + Crack. 
http://files.9down.com:8080/CuteFTP.Pro.v8.3.2.Build.09.02.2008.1.Incl.Crack.rar 

 
2. Nhấp lên chữ nầy > Nhấp lên Hàng chữ sau chữ Download . (H1). 

http://utbinh.com/ANOV08/131108/9down.doc
http://www.9down.com/
http://files.9down.com:8080/CuteFTP.Pro.v8.3.2.Build.09.02.2008.1.Incl.Crack.rar
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3. Ra Trang Live-Share đang đếm ngƣợc dần từ 5 đến 1 , nhấp Phải lên hàng chữ 
xanh > Hiện ra Bảng Download File Info , nhấp Nút Browse ( Ô Vuông có 3 chấm 

) > Chọn vị trí Down về là Desktop > Dung lƣợng phần mềm 8.44 MB , nhấp Nút 
Start Download . (H2). 

 

 
 

 
 

 
 
 

 
 

 
 
 

 
 

 
 

 
 

II.CÀI ĐẶT PHẦN MỀM : 
 

1. Giài nén File Rar nầy bạn có 2 Folders : setup và crack > Tạo 1 Folder tên : 

cuteFTP8.3 Pro tại Desktop để chứa 2 Folders vừa giải nén . 
2. Nhấp lên Folder setup > Hiện ra File : cuteftppro ( 8752 KB ) , nhấp lên để bắt 

đầu cài đặt > Next > Finish . 
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3. Nhấp lên Folder crack > Hiện ra 2 Files , copy 2 Files nầy > Phím Window+E > 
Chọn Ổ C\Program Files\GlobalSCAPE > Qua Phải nhấp lên Folder CuteFTP 8 

Professional > Ctrl+V > Nhấp lên File vừa Paste vào là : cuteFTPpro v8.3.2.Buils 
09.02.2008.1-nope ( 65 KB ) > Hiên ra File Patch > Nhấp lên chữ Patch > Nhấp 

lên Exit . (H3). 
 

 
 
 

 
 

 
 
 

 
 

 
 

 
 
 

 
 

 
4. Tạo Shortcut tại Desktop : Start > All Programs > GlobalSCAPE > CuteFTP 8 

Professional > Paste lên Desktop. 
5. Kiểm tra Bản Quyền đã đăng ký : Nhấp lên Shortcut vừa tạo tại Desktop  > Hiện 

ra giao diện của chƣơng trình > Nhấp Menu Help > Chọn About CuteFTP > Hiện 

ra Bảng thông báo tên ngƣời đã đăng ký quyền sử dụng . ( Tên của ngƣời tạo 
File Patch nầy ) .(H3a). 

 
 

 
 
 

 
 

 
 
 

 
 

 
 

IV.UPLOAD FOLDER WEBSITE LÊN HOST FREE 
 

Có 2 cách Upload Software lên Host Server : 
 
 

1. Cách Thứ 1 : Ít dùng . 
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Tạo 1 Folder tại Desktop , đặt tên site200809 ( Ngày Tạo Trang Web ) > Rê File 
nén Sotware vào trong Folder này > Dùng Chƣơng Trình Upload Folder này  

( Xem hƣớng dẫn Download – Cài Đặt và Sử Dụng Chƣơng Trình Upload bằng 
giao thức FTP là Cute FTP Pro 3.0 của utbinh đã viết hƣớng dẫn  tại  : 

http://utbinh.com/ANOV08/141108/CuteFTP.doc ) lên Host Server > Khi 
Upload hoàn tất , bạn giải nén File nén . Tùy theo Host Server có hổ trợ giải nén 

trên Host hay không mà áp dụng cách thứ 1 này .. 
 

2. Cách Thứ 2 : Thƣờng dùng . 

 
Tạo 1 Folder tại Desktop , đặt tên site200809 ( Ngày Tạo Trang Web ) > Rê File nén 

Sotware vào trong Folder này > Giải nén > Delete File nén > Dùng Chƣơng Trình 
Upload Folder này ( 25.80 MB ) lên Host Server bằng Chƣơng Trình Cute FTP hay 
Smart FTP . 

 
 

Sau khi bạn Download hoàn tất Phần mềm Joomla – Giải nén và tạo 1 Folder tên 
byethost  chứa toàn bộ các Files cấu tạo nên Trang Web mẫu Joomla , đặt tại Desktop , 

bạn cần Upload nó lên Host Server Free . 
 

1. Tạo Site Manager : Bạn cần tạo Site Manager để Chƣơng Trình Cute FTP mới có 

thể kết nối với Host Server , từ đó bạn Upload Folder joomla lên Host Server . 
Cách tạo Site Manager nhƣ sau : 

¶ Nhấp Shortcut Cute FTP tại Desktop > menu File > New > FTP_Site > HT 
Site Properties for hiện ra > Nhập các thông số trong Mục FTP Server do 

Host cung cấp . (H8). 
 

 
 

 
 
 

 
 

 
 
 

 
 

 
 

 
 
 

 
 

 
 

¶ Nhấp Folder Trung gian của Host Free là : htdocs bên Phải > Bật ra Khung 
Host mới , đây là phạm vi hiển thị nội dung các Folders mà bạn sẽ Upload 

vào . 

http://utbinh.com/ANOV08/141108/CuteFTP.doc
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2. Cách Upload : Rê Folder : byethost tại Desktop qua Phải . Thời gian Upload này 
rất lâu do bạn dùng Host free thì đành phải chịu vậy thôi .  

Khi hoàn tất sẽ có những dấu hiệu sau đậy : Có tên Folder joomla trong Khu vực 
Host – Khung giữa có chữ : Directory listening completed  - Khung đáy có 100% 

màu xanh . Nhƣng đôi khi đến 98-99% thì không thấy diễn tiến nào cả . (H9) . 
 

 
 
 

 
 

 
 
 

 
 

 
 

 
 
 

 
 

 
 

 
 
 

3. Nhấp lên Folder joomla trong khu vực Host  > Hiện ra các chi tiết trong Folder  
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4. Kiểm tra trên Trình Duyệt : bạn lấy thông số của Host cung cấp cho bạn là :  
Website URL: http://chunhat.byethost33.com và tên Folder vừa Upload là 

byethost để tạo thành Link : http://chunhat.byethost33.com/byethost 
 

 
 

 
 
 

 
 

 
 
 

 
 

 
 

 
 
 

 
 

 
 

 
5. Trở về Cửa Sổ Cute FTP , sau khi Upload xong bạn phải xóa các Thuộc tính Chỉ 

Đọc ( Read Only ) của các Files và Folders cài đặt .Nếu không thực hiện điều này 

thì trong quá trình cài đặt sẽ bị thông báo lỗi do các thông số cài đặt không đƣợc 
cập nhật vào các Files Read Only này .  

Cách thực hiện nhƣ sau : 
o Nhấp Folder joomla trong Khu vực của Host ( Bên Phải ) > Hiện ra Các 

Files và Folders này > Chọn tất cả > Nhấp Phải > Chọn Properties > 
Permission nhập : 777 > Trong Mục Owner ở dƣới tự động chọn hết các 
nút > Apply > Ok .(H10) . 

 
 

 
 

 

 
 

 
 

 
 
 

 
 

 
 

 

http://chunhat.byethost33.com/
http://chunhat.byethost33.com/byethost
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V.TẠO DATABASE TRONG HOST SERVER FREE 
WWW.BYETHOST.COM 

 

Sau khi đăng ký tạo Account thành công , bạn nhận đƣợc E-mail của Server cung cấp 
các thông tin . Nhƣ đã hƣớng dẫn ở trên , bạn cần phải biết dùng các thông tin này để 
tạo Database Trong MySQL và trong FTP .(H1). 

 
 

 
 

 
 
 

 
 

 
 
 

 
 

 
 

 
 
 

 
 

1. Vào Control panel : Nhấp link trong Cpanel URL là : 
http://cpanel.byethost33.com 

2. Nhập User name và Password vào ( Lấy trong Cpanel Username và Cpanel 
Password ) là : b33_3721618 và 05072009 . (H2). 

 

 
 

 
 
 

 
 

 
 

 
 
 

 
 

 
 

3. Ra Trang kế tiếp , bạn đọc các thông tin chi tiết ở Cột Trái  về tài khoản của bạn , 
các chức năng đƣợc Host Free cung cấp > Mục Database , nhấp MySQL database 
. (H3). 

http://cpanel.byethost33.com/
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4. Ra Trang tiếp theo , nhập trong Trƣờng Make a New database : phuong  ( Tự đặt 

1 tên nào đó cũng đƣợc ) > Nhấp Nút Create Database . Host này cho phép bạn 
tạo 50 Database (H4) . 

 
 

 
 
 

 
 

 
 

 
 
 

 
 

 
5. Ra Trang tiếp theo , thông báo bạn đã dùng 1/50 database và database mà bạn 

vừa đặt tên có Name : b33_3721618_phuong. 
6. Tiếp tục kích hoạt cho Database :  

¶ Để con trỏ lên Tab Control Panel > Ra Menu xổ xuống , chọn Site Manage 

> Chọn File manage . (H15a) . 
 

 
 

 
 

 
 
 

 
 

 
 

 
 
 

 



19 
 

¶ Ra Trang tiếp theo  , nhấp lên Folder htdocs ( đây là Folder Trung Gian của 

Host Server ) . (H15b) . 
 

 
 
 

 
 

 
 

 
 
 

 
¶ Ra Trang tiếp theo , nhấp lên Folder đã upload là byethost . (H15c) . 

 
 

  
 

 
 
 

 
 

 
 

 
 

¶ Ra Trang liệt kê các chi tiết nằm trong Folder byethost . (H15d) . 
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¶ Nhấp Nút Upload > ra rang tiếp theo > Nhấp Nút màu xanh ( Nút Submit 

accesskeyv ) . (H15e). 
 

 
 
 

 
 

 
 

 
 
 

 
 

 
¶ Ra Trang Upload more Files and Archives . (H15f) . 

 
 

 
 
 

 
 

 
 

 
 
 

 
 

 
 

VI.CÀI ĐẶT SOFTWARE JOOMLA1.5.14 
 
 
Sau khi bạn đã : Upload Software lên Host Server thành công – Đã xem Trang :  

http://chunhat.byethost33.com/byethost/installation/index.php - Đã nhập 777 để 
xóa các Thuộc tính Read Only cho các Files của Software trên Host – Đã tạo 1 
Database tên : b33_3721618_phuong thì khi bạn mở Trang Web này , bạn bắt đầu cài 

đặt Phần Mềm Joomla PHP trên Host từng bƣớc một ( Có tất cả 7 bƣớc – Mỗi bƣớc là 1 
Trang Web ) . 

 
1. Bƣớc 1 :  

 
¶ Ở bƣớc này, bạn sẽ chọn ngôn ngữ cho quá trình cài đặt của mình ,mặc 

định là tiếng Anh, ngoài ra còn có nhiều thứ tiếng khác nữa. Sau khi chọn 
ngôn ngữ : en-Us – English (US) > Nhấp Next . (H11). 

 
 
 

http://utbinh.com/site200809/installation/index.php
http://utbinh.com/site200809/installation/index.php
http://utbinh.com/site200809/installation/index.php
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2. Bƣớc 2 : PRE-INSTALLATION CHECK ( Kiểm tra tiền cài đặt ) . 
 

Bƣớc này là bƣớc kiểm tra các thiết lập hệ thống của bạn có đáp ứng đƣợc yêu 
cầu của Joomla hay  không, bƣớc này có 2 phần nhỏ: 
Phần 1 là các thiết lập hệ thống mà bạn bắt buộc phải đáp ứng để cho quá trình 

cài đặt có thể diễn ra suôn sẻ, nếu có bất kỳ thiết lập nào trong phần này của 
bạn bị đánh màu đỏ, bạn phải tìm cách thiết lập lại, và sau đó nhấn nút Check 

Again để kiểm tra lại. 
Phần 2 là các thiết lập ko ảnh hƣởng nhiều tới quá trình cài đặt Joomla nhƣng sẽ 

ảnh hƣởng tới hoạt động của Joomla sau này, nếu bạn có 1 vài thiết lập ko đáp 
ứng đƣợc ( màu đỏ ) thì cũng ko sao, tuy nhiên nếu bạn có thể đáp ứng đƣợc hết 
thì quá tốt, trong hình minh hoạ này, tôi có thiết lập register_global ko đáp ứng, 

vì ngoài Joomla ra thì tôi còn cài 1 số sản phẩm khác và chúng đòi hỏi 
register_global  . 

¶ Đọc các thông tin > Nhấp Next .(H12) . 
 

 
 

 
 
 

 
 

  
 

 
 
 

 



22 
 

3. Bƣớc 3 : LISENCE( Quyền hạn ) .  
 

¶ Một danh sách dài các điều khoản trong giấy phép GNU/GPL, sẽ rất tốt nếu 

bạn có khả năng hiểu hết những điều khoản và tuân theo nó, trong bất kỳ 
cuộc chơi nào, luật lệ luôn luôn là 1 phần quan trọng , rất may là trên 
wikipedia tiếng Việt đã có bản dịch giấy phép này, bạn có thể đọc nó tại 

đây . 
http://joomlaviet.org/forum/index.php?topic=161.0 

¶ Đọc các thông tin. > Nhấp Next . (H13) . 
 

 
 

 
 
 

 
 

 
 

 
 
 

 
 

 
 

 
 
 

 
 

4. Bƣớc 4 : DATABASE ( Cở Sở Dữ Liệu ) .  
 

Đây là bƣớc rất quan trọng và gây rất nhiều khó khăn cho các bạn mới tìm 

hiểu, nếu bạn thấy khó khăn trong bƣớc này, đừng ngại và hãy đặt câu hỏi 
bên dƣới  

Tôi sẽ giải thích các phần bạn phải điền trong bƣớc này 
Database Type: Hiện MySQL hỗ trợ 2 chuẩn là mysql và mysqli ( mới hơn ), 

nên chọn mysql 
Host Name: nếu bạn sử dụng MySQL  trên chính máy bạn cài Joomla ( 
trong 90% trƣờng hợp ) thì bạn điền vào là localhost, còn trong trƣờng 

hợp khác, bạn sử dụng MySQL và truy xuất database thông qua 1 máy 
khác, thì bạn hãy điền tên host đó hoặc IP của host đó vào đây 

Username: tài khoản MySQL của bạn, nếu bạn dùng trên localhost thì tài 
khoản này thƣờng là root ( tài khoản có mức ƣu tiên cao nhất ), trong 

trƣờng hợp các bạn dùng các host shared thì tài khoản này chỉ có tác dụng 
trong host của bạn và bị giới hạn 1 vài tính năng, nếu bạn chƣa biết rõ 
thông tin tài khoản MySQL của mình, hãy liên hệ với nhà cung cấp host để 

có hƣớng dẫn cụ thể 
Password: mật khẩu tài khoản MySQL 

Check user’s create privileges : bƣớc này sẽ kiểm  tra về quyền của tài 
khoản MySQL trên, nếu tài khoản của bạn có đủ quyền để tạo CSDL mới thì 

http://joomlaviet.org/forum/index.php?topic=161.0


23 
 

bƣớc này coi nhƣ xong, còn nếu tài khoản của bạn bị giới hạn, hãy liên hệ 
với nhà cung cấp host để yêu cầu tài khoản mới . 

Available collations : bƣớc này bạn sẽ chọn cách mà database đƣợc mã 
hoá, hãy chọn Utf8_general_ci 

Database name: bƣớc này bạn hãy chọn cho database của mình 1 cái tên, 
hãy chọn 1 cái tên dễ nhớ và đặc trƣng cho trang web mà nó lƣu CSDL 

Advanced Settings: Các thiết lập nâng cao, ở đây bạn nên quan tâm tới 
mục prefix, prefix nghĩa là tiền tố,nó sẽ đứng trƣớc tên của các table trong 
CSDL và dùng để phân biệt với các table khác, nếu bạn có dự tính cài đặt 1 

số component cho bản Joomla này, hãy lên danh sách ngay bây giờ và tìm 
hiểu chúng trƣớc khi cài, vì có 1 số component hay module có yêu cầu liên 

quan tới prefix này, bạn có thể tham khảo thêm thông tin tại đây 
http://joomlaviet.org/forum/index.php?topic=89.0 

¶ Bạn vào trang : http://panel.byethost.com > Nhập Username và Password 

–Nhấp Login . (H14). 

 
 
 

 
 

 
 

 
 
 

 
 

 
 

 
 
 

 
 

 
 
 

 
¶ Ra Trang kế tiếp , nhấp MySQL Datavase .(H15). 

 
 

 
 

 
 

 
 
 

 
¶ Ra Trang Account Information , Trang này có đầy đủ chi tiết để bạn nhập 

vào : 
o Database Type ( Kiểu Cơ Sở Dữ Liệu ) : mysql 

http://joomlaviet.org/forum/index.php?topic=89.0
http://panel.byethost.com/
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o Host name ( Tên Máy Chủ ) : Bạn đã có MySQL host name là : 
sql306.byethost33.com 

o User name ( tên đăng nhập ) : Bạn đã có MySQL User name là : 
b33_3721618 

o Password ( mật khẩu ) : 07052009 
o Database name ( tên Cơ Sở Dữ Liệu ) : b33_3721618_phuong. 

(H16). 
 
 

 
 

 
 
 

 
 

 
 

 
 
 

 
 

 
 

 
¶ Nhƣ vậy trong bƣớc 4 này bạn nhập nhƣ sau : 

o Database Type : Mặc định chọn mysql. 
o Host name : sql306.byethost33.com 

o User name : b33_3721618 
o Password : 05072009 
o Database name : b33_3721618_phuong > Next . (H18). 
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5. Bƣớc 5 : FTP CONFIGURATION ( Cấu hình phƣơng thức truyền tải FTP ) .  
 

¶ Chọn NO trong Enable FTP file system Layer ( Lớp Tập tin hệ thống FTP có 

thể ) . 
¶ FTP User : b33_3721618 ( User Name của bạn ) . 

¶ FTP Password : 05072009 . 
¶ FTP Root Path  ( Đƣờng dẫn gốc FTP ) : Vào Mục Account Information > 

Copy đƣờng dẫn của Home Path > Dán vào FTP Root Path này > Next . 

(H19-20) . 
 
 

 
 

 
 

 
 
 

 
 

 
 
 

 
 

 
 
 

 
 

 
 

 
 
 

 
 

 
6. Bƣớc 6 : CONFIGURATION ( Cấu hình )  

 

Configuration Install default sample data: nếu bạn chƣa quen thuộc với 

Joomla, hãy cài đặt các dữ liệu mẫu để bạn có cái nhìn tổng quát về cách mà 

Joomla làm việc, sau này bạn có thể xoá bỏ nó đi 1 cách dễ dàng 
Load local Joomla! 1.5 SQL script : nếu bạn có cài đặt 1 trang dùng 1.5 trƣớc đây 

và muốn dùng lại dữ liệu bạn đã có ở trang đó, hãy export dữ liệu từ bản 1.5 cũ 
và load nó tại đây. Chú ý về table prefix, bạn cần table prefix giốgn nhau ở cả 

bản mới và bản cũ, đƣợc mã hoá bằng Unicode ( utf8 ) và khớp với cấu trúc CSDL 
của Joomla 1.5 
Load migration script : dùng để nâng cấp các trang từ phiên bản 1.0.x lên 1.5, 

vấn đề này sẽ đƣợc trình bày trong bài viết sau, cuối cùng hoàn tất các mục Site 
Name và Confirm the admin email and password. 
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Nhập các thông tin vào : 

 
¶ Site Name : CAIDAT_TRÊN_HOSTFREE  (Đây là tên  hiện ra trong dầu  

Trang Web . Bạn có thể đặt tên nào cũng đƣợc )  
¶ Your Email : utbinhdesign@gmail.com ( Hộp thƣ liên lạc ) . 

¶ Admin Password : 25092009 ( Đặt Mật Khẩu dùng cho Admin – Cái nào 

cũng đƣợc ). 
¶ Confirm Admin Password : 25092009  ( Mật khẩu cho Admin  ).  

¶ Nhấp lên Khung có chữ : Sample data installed > Hiện ra chữ : Sample 

data installed successfully ( Thông báo Mẫu dữ liệu đã cài đật hoàn tất ) . 
¶ Nhấp Next . (H21) . 

 
 

 
 

 
 
 

 
 

 
 
 

 
 

 
 

 
 
 

 
 

7. Bƣớc 7 : FINISH ( Hoàn tất ) . 
 

 
 
 

 
 

 
 
 

 
 

 
 

 
 
 

 
 

mailto:utbinhdesign@gmail.com
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Đến đây thì bạn đã hoàn tất các bƣớc trong việc cài đặt Joomla, hãy xoá bỏ thƣ 
mục Installation trƣớc khi vào trang web mới cài đặt của bạn . 

 
 

 
 

 
 
 

 
 

 
 
 

 
 

 
 

 
 
Các bạn có thể thảo luận về vấn đề này tại đây  
http://joomlaviet.org/forum/index.php?topic=434.msg1982;topicseen#msg1982 

¶ Có hƣớng dẫn : Bạn sẽ không thể tiếp tục nếu bạn chƣa xóa Folder 

Installation.  Vậy bạn nên vào Chƣơng Trình Cute FTP khu vực Host Delete 
Folder Installation thì mới có thể tiếp tục vào Trang Web đang cài đặt . 

Đây là một tính năng bảo mật của Joomla . 
¶ Thông báo Usename của bạn là : admin. 

¶ Nhấp Nút site để xem Trang Web mà bạn vừa cài đặt thành công . 

 
 

 
 
 

 
 

 
 
 

 
 

 
 

 
 
 

 
 

 
 

 
 
 

http://joomlaviet.org/forum/index.php?topic=434.msg1982;topicseen#msg1982
http://joomlaviet.org/forum/index.php?topic=434.msg1982;topicseen#msg1982
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¶ Nhấp Nút Admin để xem quyền quản lý của bạn . 

¶ Muốn chuyển đổi Trang Web Joomla sang ngôn ngữ Tiếng Việt , nhấp lên  
Trang Help Site của Joomla có thêm thông tin và tải về .  

  
 

NGÀY 5.7.2009 :  
35.HOST FREE : BYETHOST NUMBER ONE  

<img src=http://utbinh.com/A7/050709/BYETHOST.jpg> 
[img]http://utbinh.com/A7/050709/BYETHOST.jpg[/img] 
http://utbinh.com/A7/050709/BYETHOST.jpg 

http://utbinh.com/A7/050709/BYETHOST.doc 
http://utbinh.com/A7/050709/BYETHOST.pdf  

DOWNLOAD FILES VIDEO TUTORIALS :  
Video Định dạng AVI cực rõ tạo bằng Chƣơng Trình Camtasia Studio 6.0.1 

(http://tinyurl.com/utbinh174 )  
Hƣớng dẫn tạo ACCOUNT và sử dụng Host Free BYETHOST : 
http://tinyurl.com/utbinh189 

HOST FREE BYETHOST ngày 5 7 2009 Tập 1  
http://www.youtube.com/watch?v=xY8JC_sDyZo 

HOST FREE BYETHOST ngày 5 7 2009 Tập 2 HẾT  
http://www.youtube.com/watch?v=r-zVgeAeR6I 

ĐỌC THÊM TÀI LIỆU HƢỚNG DẪN SỬ DỤNG BYETHOST : 
Hƣớng Dẫn Cài Đặt WordPress Với ByetHost Cho Newbies (Updated) : 

http://blogviet.info/2009/02/huong-dan-cai-dat-wordpress-voi-byethost-cho-
newbies/ 
Cách tạo website và forum tại www.byethost.com bằng joomla và vBulletin : 

http://forum.gamevn.com/showthread.php?t=319040 
Tìm Hiều Host Free : BYETHOST trong Shared Mediafire : 

http://tinyurl.com/utbinh188 
Trang Byethost15.com signup thông báo các chi tiết về Files and FTP Settings ( 

Tên URL – Username – Password ) để bạn tạo Site Manager  trong Chƣơng Trình 
Upload bằng giao thức FTP . Riêng về sử dụng Control Panel – MySQL Settings – 
Domain Name bạn tham khảo trong : http://tinyurl.com/utbinh188 

Bạn cần phải Upload Folder Website lên Host Server bằng Giao Thức FTP để lấy 
Link URL ( Tìm hiểu Giao Thức FTP : http://vi.wikipedia.org/wiki/FTP - 

http://ipmac.vn/forum/showthread.php?t=261 ). Có rất nhiều Phần mềm 
chuyên dùng FTP nhƣng theo Utbinh thì sử dụng Chƣơng Trình Cute FTP Pro 3.0 
này 2 là thích hợp nhất . Các bạn có thể tham khảo trong : 

http://utbinh.com/ANOV08/141108/CuteFTP.doc 
Trình Duyệt IE hay FireFox > Hàng Address nhập :  

http://www.thunam.byethost15.com/site010709/index.htm 
Giải  thích Link URL : 

http://www.thunam.byethost15.com : Link do Byethost cấp khi đăng ký . 
site010709 : Folder Website đã Upload lên Host Server 
index.htm : Trang Chủ của Trang Web . 

 
NGÀY 14.11.2008: 

5.FRONTPAGE 2003 : CUTE FTP 8.3 PRO 
<center><img 

src=http://utbinh.com/ANOV08/141108/cuteFTP.jpg></center> 
[img]http://utbinh.com/ANOV08/141108/cuteFTP.jpg[/img] 
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http://utbinh.com/ANOV08/141108/cuteFTP.jpg 
http://utbinh.com/ANOV08/141108/CuteFTP.doc 

http://utbinh.com/ANOV08/141108/CuteFTP.pdf 
DOC 708 KB – PDF 763 KB – JPG 1.07 MB . 

Tìm hiểu Giao Thức FTP 150 KB : 
http://utbinh.com/ANOV08/141108/TimHieu_CutFTP.doc 

Kết quả thực tập Thiết kế Web ONE PAGE2 : 
http://utbinhutbinh.110mb.com/site141108/indexB.htm 
http://utbinh.com/ANOV08/site141108/indexB.htm 

http://utbinh.com/ANOV08/121108/site121108/index.htm 
http://kimtrang.110mb.com/site121108/index.htm 
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